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Introduction

Welcome to NeuroCheck version 5.1, the professional system for industrial image 
processing under Microsoft Windows 7/Vista/XP. NeuroCheck is one of the leading 
image processing systems on the market, and we are happy to make all our know-how 
available to support you.

This manual introduces you to NeuroCheck and shows you how to get comprehensive 
information for working with NeuroCheck; furthermore, it will help you with problems 
and contains hints for troubleshooting. It is primarily written for operators and set-up 
people working with NeuroCheck visual inspection stations. For users who would like to 
know more about image processing in general, we offer two-day training courses. 

The contents of this manual have been checked for compliance with the described 
hardware and software. Due to the rapid development of hardware and software, 
differences from procedures described here cannot be excluded, which is why complete 
compliance cannot be guaranteed. Necessary changes will be made on a regular basis in 
the following editions. 

We are grateful for feedback regarding your experience with this documentation and 
welcome any suggestions.
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1 Working with NeuroCheck 

In this section you will learn

• what NeuroCheck is,

• how to start and shut down your system,

• what operating modes are available in NeuroCheck,

• what the user interface looks like and how to work with it,

• how a check routine is made up, how dialogs are accessed, and

• how signals are exchanged with a superior control system.

1.1 What is NeuroCheck
NeuroCheck is a universal image processing system designed for use within automatic 
production processes and quality management systems. It offers an integrated environment 
for the interactive configuration of visual inspection applications and their automatic 
execution on the manufacturing line. The following figure shows the schematic setup of a 
NeuroCheck inspection system including the necessary hardware components and 
communication links in a basic configuration.

With its comprehensive set of image processing functions, NeuroCheck can be used in a 
wide range of application areas. A highly automated check routine configuration and an 
intuitive graphical user interface help to solve visual inspection problems. 

Because of its ability to exchange data with other Windows applications using the 
Windows clipboard or to create comprehensive inspection records via files and serial data 
communication, NeuroCheck is ideal for use with highly integrated manufacturing lines 
and integration into modern quality management systems.
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NeuroCheck can be controlled using digital I/O, serial interface, and OLE automation. It is 
even possible to change check routines via remote control, i.e. to reconfigure the whole 
inspection system within milliseconds. The following figure shows the setup of a 
NeuroCheck inspection station including all possible connections.

Even a communication protocol as flexible as that of NeuroCheck cannot take into 
account the special features of every PLC available on the market. Therefore, NeuroCheck 
offers a fully documented DLL interface to use customer defined communications 
protocols (OEM communication), thus fitting seamlessly into today’s highly integrated 
manufacturing processes.

Extensibility
NeuroCheck can be extended in various ways opening up new dimensions of performance 
and flexibility:

• Plug-in DLLs contain user-defined image processing functions. The functions are 
seamlessly integrated into the NeuroCheck environment, i.e. you can use the entire 
functionality of the NeuroCheck framework, including parameter copying, output to 
different recipients, visualization of run-time data... For example, you can create your 
own preprocessing functions, support manufacturer specific communications 
protocols, and do anything too specialized for a standard software package.

• OEM communication DLLs support any communication hardware with an interface 
equivalent to the serial driver included with NeuroCheck.

• Via OLE automation you can control NeuroCheck from your own Visual C++ or 
Visual Basic applications to give your inspection system an individual user interface. 
The OLE interface consists of approx. 100 functions giving access to all relevant 
functions and parameters in NeuroCheck.
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File Output
Wherever it is useful, NeuroCheck functions allow for writing result data to files. This 
includes measurement values as well as images and check results. Interactive 
configuration of the file format makes it possible to process the data with standard 
software (e.g. Microsoft Excel). Thus NeuroCheck meets the requirements of modern 
quality management for comprehensive inspection records.

1.2 Start and Close System

Start System
Switching on the computer automatically starts the check routine in automatic mode. In 
this mode the system waits for the signal Start Check from the superior control system.

Switch off System
To avoid loss of data, the inspection system may only be switched off after an already 
started measuring cycle has been finished. Note that the computer may not be switched off 
directly but must be properly shut down. Terminate NeuroCheck with the Exit command 
from the Check Routine menu. Click on the Start > End button on the windows task bar. 
When the message “It is now safe to turn off your computer” appears, you may switch off 
your computer. 

If the computer was not shut down in the prescribed manner (system crash, oversight, 
electricity failure), the error message “Windows was not shut down correctly” appears 
when restarting the system. Confirm by pressing a key. The “ScanDisk” program will be 
run. Afterwards Windows starts and NeuroCheck is started automatically.

If your computer is already equipped with an uninterruptible power source (UPS), you 
will not notice significant changes when switching your computer on or off. The UPS 
checks in the background whether the computer is switched off and switches itself off 
automatically within 3 seconds. The same is true for switching the computer on. The UPS 
switches itself back on automatically (for additional information about UPS see “Data 
Integrity for your System” on page 79).
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1.3 Operating Modes
This section explains the different modes of operation in NeuroCheck.

1.3.1 Automatic mode
The item Automatic in the Operating modes menu or the corresponding icon switches 
the system into automatic mode. The check routine is carried out automatically with 
NeuroCheck being remote controlled by PLC or a master computer.

The fundamental settings for automatic mode are valid for the software as a whole, i.e. for 
all check routines since they refer directly to the configuration of the surrounding 
production process that will change only infrequently. They are set in the Remote Control 
dialog box which you can access using the corresponding menu item from the System 
menu.

1.3.2 Manual mode
After start of the program, NeuroCheck is usually in automatic mode. To switch to manual 
mode click the depicted button on the tool bar or select Manual from the Operating 
Modes menu. In this mode the check routine can be edited and carried out step by step 
manually.

1.3.3 Live Image Mode
You can reach this mode by clicking the depicted button or by selecting the menu item 
Live from the Operating Modes menu. The complete program window is then used to 
display the current live camera image. If more than one camera is connected, select the 
desired camera from a list. To focus more easily, the zoom factor can be changed. This 
mode is primarily used to check and set up focus and exposure of the cameras.

Manual mode

Live image

Automatic mode
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1.4 User Interface
The user interface of NeuroCheck was designed to make using a digital image processing 
system as easy as possible but also to offer all possibilities to the experienced user. It 
therefore allows you access to all options and function parameters, but does not require the 
user to set all of them by hand because of its mostly automatic configuration.

True to the Windows 9x/2000/XP philosophy, NeuroCheck supports intuitive use of the 
right mouse button. Object properties, parameter settings, online help, clipboard, 
everything can be accessed using the right mouse button. At the same time, most functions 
offer traditional control elements for an immediate overview of the current configuration.

1.4.1 Description of the toolbar.

Open
Lets you select a check routine file from a file select box. 

Save
Saves the active check routine. 

Information About The Program
Displays the About NeuroCheck dialog box with information on the current program 
version and the system environment.

Manual mode

Live image

Automatic mode

Parameter/target 
value input

Security Profiles

Adjust camerasInformation about the 
program

Save
Help

Automatic mode 
configuration

Read from bitmap

Open
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Help
Clicking this button on the standard toolbar changes the mouse cursor into a contextual 
help cursor. Clicking any element on the NeuroCheck user interface will then display a 
help window with information about the element.

Manual Mode
Switches to manual mode, the primary mode for check routine editing.

Live Image
Switches to live mode, using the whole of the NeuroCheck window for live image display.

Automatic Mode
Switches to automatic mode in which NeuroCheck performs automated visual inspections 
under remote-control communicating through various channels with external devices, like 
PLCs and master computers. 

Configuration of Automatic Mode
Switches to automatic screen configuration mode used to configure the layout of the 
automatic mode screen shown by NeuroCheck when executing the current check routine 
in automatic mode.

Read from Bitmap
This command temporarily switches input of all Transfer image functions in the check 
routine to bitmap files instead of camera images. By using this feature applications 
involving several cameras can be edited without taking care that the right piece is placed in 
front of each camera.

Security Profiles
Opens the Security Profiles dialog for configuring security levels for this NeuroCheck 
installation. 

Adjust Cameras
This function opens the Adjust Cameras dialog which allows you to compare reference 
images to the current camera image for adjusting camera positions.
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Parameter/Target Value Input
This command displays the Parameter/Target Value Input dialog for setting parameters 
and target values for selected functions in automatic mode.
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1.4.2 Automatic Mode Screen

The automatic mode screen displays the processing results of the check routine in various 
windows.

Automatic Screen Background
In automatic mode, the output windows for visualization can be moved in the foreground 
of the automatic screen. For the background, there are three different display types 
available:

• A simple white background.

• A background image (e.g. a company label) without any further functionality.

• A HTML background (similar to an internet page) with interactive elements like 
buttons, text links or graphics.

Since the HTML background allows you to control NeuroCheck, we will explain this 
feature in more detail now.

Automatic mode Configuration of automatic mode
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Interactive HTML background
In addition to the graphical presentation of text and graphics, a HTML background can 
contain elements with functionality. This enables you to perform an action by clicking the 
corresponding element with the mouse. Such an action could be, for instance, the change 
of the check routine, the reset of the statistics or the activation of the target value dialog 
(See “Publishing Target Values” on page 82.).

In this example the default NeuroCheck HTML background is used. The buttons on the 
left side of the screen represent commands which can be activated via mouse click. Note, 
that the mouse cursor changes when moved over an interactive element, like a button in 
this case. Text links are normaly presented underlined.

The visualization windows can be changed in size and position, so it is possible that some 
of the interactive elements might be hidden behind these windows.
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Function Keys
Another possibility to send commands to NeuroCheck is the usage of function keys. The 
keys F1 to F12 on your keyboard are free configureable with several commands in the 
settings for automatic mode.

Here is another example of a HTML background. The function keys are displayed at the 
bottom of the screen. The command assigned corresponding to the function key (e.g. 
F1=Help) is also displayed as a text link above the image of the key. The command „call 
Help window“ could be activated in three different ways:

• Press the F1 key on your keyboard.

• Click on the image of the F1 key on the HTML background.

• Click on the text link „Help“ above the image of the F1 key.

All three ways have the same effect, e.g. the help window appears.

Automatic Screen Configuration Mode
The Configure Automatic Screen command from the Operating Modes menu or the 
depicted button enable you to configure the screen display in automatic mode. This 
display is part of the check routine since it allows customized assignment of output 
windows to check functions for the output of result values or images. Thus the screen 
configuration depends on the check functions contained in the check routine.
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Screen Layouts
In NeuroCheck you can choose from several screen layouts. However, these must have 
been configured and saved. 

If this is not the case, we recommend to create a screen for debugging besides the standard 
screen. On this screen, all important check routine functions can be displayed as images. 
This helps you to check whether the positioning was carried out correctly, whether the 
thresholded image or the ROIs were created correctly etc. In the communication window, 
the inputs and outputs are displayed. Using this window, you can check the 
communication with the control system.

A new layout is created using the depicted icon or by choosing Screen Layout > New 
from the View menu. 

If the check box Use template is activated, you can choose standard layouts from a list. 
You can also create your own screen using the toolbox. 

Delete Layout

Arrange

New Layout
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Here you see a screen layout based on the Debug template.

The new layout contains: system log, debug, check function visualization, digital I/O and 
serial communication status windows, and an execution time window.

For the windows to display the desired information, parameters have to be set using the 
right mouse button. 

From the context menu of the Diagnostics/maintenance window choose Parameters. 
Activate the check boxes Check function status and Internal error codes. The 
Diagnostics/maintenance window then lists every single check function executed during a 
check routine. The two check boxes activate additional output, listing error codes of the 
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functions, which can be very helpful for the NeuroCheck technical support team to find 
the cause of a problem.

For further information please refer to the help files or the user manual.

1.4.3 Manual Mode Interface

Here you see the NeuroCheck window in manual mode. The main window is divided into 
the edit pane on the left, featuring five tabbed edit pages, and the result image display on 
the right. The bottom border of the window contains the status bar, which keeps you 
informed about the current state of the program.

Manual mode

Stopwatch

Image tray

Read from bitmap
Ignore I/O

Edit area Result display
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Result Display

The output pane in the right area of the manual mode screen is used to display results as 
well as input and output data of the check function just carried out.

You can switch between the various views of results offered by the check function using 
the tabs. This way it is easy to see what is currently being displayed and which options are 
available.

Result display allows for different zoom levels that can be switched using a list box. 

Result images can be saved from the window into a bitmap file or copied to the clipboard.

Splitting the result view into two horizontal areas (by pulling down the upper frame) 
allows for simultaneous viewing of two different result displays. 

Zoom levels
Save as 
bitmap file

Tabs
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Editing Tabs

The main aspects of a check routine (structure, input data, output data, execution of 
individual checks, documentation) are edited in different tabbed pages in the left window 
area. Each page offers a complete overview of the check routine, showing you where you 
are at any time. The structured display of the check routine is the default page in the 
editing area.

Structure of the
check routine

Display of input data Display of output data

Control flow of individual 
checks

Documentation
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Edit Bar

The depicted toolbar is located above the editing window by default. Since the tool bars 
can be arranged individually, it may also be found in a different location e.g. the left side 
depending on the configuration used.

Using the symbols, you can easily execute check functions and step forward and back. The 
pertaining dialogs for parameter setting, input data configuration and target values can 
also easily be opened using these icons.

Parameters

Input data configuration

Back

Next

Execute
check

Target values
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1.5 Check Routine

1.5.1 Load Check Routine

Usually, the check routine is automatically loaded when NeuroCheck starts. To perform a 
check routine change manually, click the depicted symbol or choose Open from the 
Check Routine menu.

The File Select dialog box is displayed. 

Here you can select the desired check routine from the installation directory of 
NeuroCheck (check routines have the extension *.CHR, short for “check routine”).

Click Open to confirm. 

In manual mode NeuroCheck displays the structure of the loaded check routine in the tree 
view on the left side.

Manual modeOpen
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1.5.2 Basic Structure of Check Routines

The Check routine is the core element of every image processing solution created with 
NeuroCheck. Its role can be compared to that of a text document in a word processor or a 
source code in a development environment. 

It is displayed in a tree view with the following hierarchy: 

The check routine comprises the solution of the entire inspection task. A check routine 
typically consists of a number of individual checks that take care of different aspects of the 
inspection task. The individual results can be combined by conditional branching.

In an individual check a single aspect of the entire inspection task is solved, e.g. 
recognition of writing, gauging of an object or presence verification of a part. Each 
individual check is made up of a sequence of check functions. 

A check function is an image processing, classification or system function that can be 
integrated into an individual check to fulfill a specific processing task. 
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Individual Check

Individual checks are independent of each other, they do not exchange data. Usually 
checks are executed in the order in which they appear in the check routine. However, it is 
possible to carry out a check depending on the result of another check. The result of a 
check - O.K. or n.O.K. - can be used to decide which check should be carried out next. 
This makes it possible to carry out type-dependent checks or to use different check 
methods for the same work piece. Use a simple, quick method first and only if this fails, 
use a more elaborate one so the average execution time is reduced.

Deactivate Check
It is also possible to deactivate a check. Right-click the appropriate check and select 
Properties from the context menu.

Select the Result Evaluation tab and click the Deactivate check box. Confirm with OK.

This check is now marked with a red arrow and not active for the whole inspection.

Individual checks inspect different aspects of
a work piece. A check might measure a bore
hole, verify the presence of a component or
read a line of characters. 

Each individual check consists of several
check functions. After all checks for a work
piece have been carried out, their results are
combined to form the final result of the check
routine.
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Start and End Actions
Start and end actions are special types of individual checks that can be added at the 
beginning or end of a check routine. They are always executed at a specific point in time, 
namely before resp. after all other checks in the check routine. The start actions can for 
example be used to take several pictures quickly and to buffer them in the image tray for 
later processing after the test piece has already left the check station. Some controls need a 
confirmation of the input signal by NeuroCheck. This can be accomplished by inserting a 
start action into the check routine.

The main purpose of the end actions is to synchronize NeuroCheck with the production 
process after the end of all checks, e.g. by exchanging certain digital signals. The end 
actions can also be used as a time delay to rule out undesired multiple measurings.

Check Functions
Check functions are image processing,
communications or system functions that can be
inserted into a check to carry out specific tasks.
NeuroCheck provides check functions for various
tasks, such as filtering entire images, searching
and measuring individual objects, reading from or
writing to digital I/O connectors etc.

The check functions of a check are executed in
sequence. Through a data pool, input and output
data is exchanged with a check function getting
its input data usually from the preceding check
function. This assignment can manually be
changed at will. 

The parameters of all check functions can be set independently of each other. Therefore, 
each check function contains a dialog for the Target Values or for the Parameters, which 
also provide you with appropriate visual support.
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Open Target Value Dialog
Select the check function by left-clicking it. Select this icon from the toolbar or right-click 
the context menu and select Target Values. 
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Open Parameter Dialog
Select the check function by left-clicking it. Select this icon from the toolbar or right-click 
the context menu and select Parameters. 

Check Function Name
Check functions can be given custom names. For that, right-click on the check function 
and select Rename from the context menu. Enter the new name and confirm by pressing 
Enter.

To display the default names of the check
function, activate the menu entry Display
Original Check Function Name in menu
Tools.
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1.5.3 Check Routine Documentation
For a better readability of a check routine, you can add a description to the check routine, 
its individual checks and to each check function. These comments and descriptions are 
displayed when the documentation view (using tab Documentation) is active. The 
information available for the selected item, will be shown in the right side of the screen.

1.5.4 Check Routine Example
For further information about check routines please refer to the appendix (see page 105) 
where you’ll find a complete example of a check routine. The example is described step by 
step to explain the purpose of each check function and its parameter settings.

Documentation Tab View for Documentation

Selected Item
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The example described deals with a presence verification of contact pins on a plug.

1.5.5 Save Check Routine
All changes are saved by clicking the depicted icon or by choosing Save from the Check 
Routine menu.

1.6 Automatic Start of NeuroCheck
In practice, it is often necessary that the system starts automatically after booting the 
computer. Therefore NeuroCheck has to be started directly after Windows has started. 
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Furthermore, NeuroCheck has to switch into automatic mode upon start and load a 
specific check routine.

1.6.1 Start of NeuroCheck after Booting
To start NeuroCheck automatically after Windows has finished booting, you have to 
register the program in the StartUp folder of Windows. That means that you have to create 
a shortcut to NeuroCheck in this program folder. For this configuration, it is not necessary 
that NeuroCheck is running.

First, click with the right mouse button on the
Windows Start button. A context menu will
open. Choose the menu entry Open.

Double click on the folder programs.

Now double click on the folder StartUp.
After the installation of NeuroCheck a
shortcut to NeuroCheck is created on the
Windows desktop. Move the window of
the StartUp folder so that you can see the
symbol of NeuroCheck on the desktop.

R
Right click on the shortcut symbol
of NeuroCheck and keep the button
pressed. Move the symbol into the
StartUp folder window and release
the right mouse button. A pop up
menu appears. Choose Create
Shortcut(s) here. Now Windows is
configured in a way, that it will start
NeuroCheck automatically after the
next start of Windows.

You now can close the window of
the StartUp folder.
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1.6.2 Automatic Mode after Starting NeuroCheck
It is possible to configure NeuroCheck so that it will switch into automatic mode directly 
after program start, using a predefined check routine.

Choose General Options from the System menu.

Select the option Automatic mode after program start on the Start-up Behavior page. 
Use Browse to select the check routine which has to be loaded on program start.

On the next start of NeuroCheck, it will switch directly into automatic mode, load this 
check routine, and wait for the input signal Start Check.

If NeuroCheck is configured for an automatic change of check routines (see page 36), the 
check routine corresponding to the current product type will be loaded before execution of 
the inspection run.

The external communication with signals and the automatic check routine change will be 
explained in detail in the following sections.
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1.7 Signal Exchange

Several input and output signals are available for communication between NeuroCheck 
and a superior control system. The configuration of these signals is determined by the 
application and should only be changed by authorized personnel.

1.7.1 Output Signals

System Running
The signal System running is immediately set to high level after loading NeuroCheck. It 
is continuously present while NeuroCheck is active. 

System Ready
The signal System ready is set immediately after the end of an inspection run. 
NeuroCheck then waits for a start signal.

Check Result OK/not OK
This signal is also set after an inspection run has been finished, but it depends on the result 
generated by the check routine. The output signal remains set until the next Start check 
signal. There are separate signals for OK and not OK result.
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Open the dialog box for the output signals described above by choosing Remote Control 
from the System menu. Choose the Output Signals page.

The digital output channel can be selected by choosing Options.

1.7.2 Input Signals

Start Check
The signal Start Check is only recognized by NeuroCheck if the output signal System 
ready is at high level. NeuroCheck reacts to the state of the input signal. If the signal Start 
Check is applied longer than the check routine execution time, the check routine is 
restarted immediately. If the signal Start Check is applied constantly, NeuroCheck 
executes a permanent check.

Select Check Routine
If you want to check a different type during production or if production is alternating 
between different products, NeuroCheck can load a new check routine controlled by a type 
code that is transmitted by the control system. The check routine change takes 
approximately 100 ms. 

The check routine identification number (short ID) in NeuroCheck is assigned as follows: 
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Select the check routine (not an individual check!) and choose Properties from the Edit 
menu or the context menu opened by right-clicking the check routine. 

Enter the check routine identification number on the Communication page of the dialog 
box. The number is used to change check routines during automatic mode controlled by an 
external signal.

If a check routine identification number was assigned in the NeuroCheck check routine, 
the control system needs to send not only the Start Check signal, but also the ID number 
of the check routine. For this you can use the unassigned inputs of the digital I/O. 

Select Remote Control from the System menu and activate the Select check routine 
check box on the Input Signals page.
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The digital inputs can be selected by choosing Options.

From the list of digital input channels, select the bits to be used for the identification 
number. A channel is selected by activating the check box in front of the channel name. 
The selected inputs make up a binary number in the sequence displayed. Thus the input 
listed at the top represents the least-significant bit, the one on the bottom the most-
significant bit. The output designations correspond to those specified in the Device 
Manager dialog.

Configuration of the Check Type Selection
As described before, in order to perform an automatic check routine change, a unique 
identification number has to be assigned to all relevant check routines. In addition, you 
have to specify which check routines are to be used for this change.

Choose Settings for Automatic Mode from menu System and switch to tab Check 
Routine Selection

There a two possibilities to configure the automatic check routine change.

The first possibility is to use a central directory where the check routines with different 
IDs are stored.
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Therefore, activate the option Check
routine selection from directory. Use
Browse to select the central directory,
in which the possible check routines
are located, and close the directory
selection dialog with OK. Now you
can see the selected path where
NeuroCheck will search for the check
routines.

The second possibility is to specify an individual configured list of check routines for the 
automatic check routine change. Here, the check routines can be stored in different 
directories.

For the individual list of check
routines, activate the option Check
routine selection from user defined
list. Click Add to search for check
routines and to add them to the list.
After that you can change the check
routine ID for these check routines.
Ensure that the correct ID is set and
the check box is activated for the
check routines you want to use.

After you have configured one of the
two options, close this dialog with OK
in order to apply your changes.

Now the system is ready and you can switch to automatic mode. After receiving the Start 
Check signal and the ID number, NeuroCheck attempts to load and run the check routine 
with the given identification number from the specified directory or from the individual 
defined list, depending on the selected option. 

Adjust Cameras
The Adjust cameras input signal displays reference images to check the brightness of the 
image and the camera position in automatic mode. Marks can be set at prominent image 
spots in the reference images using the Reference Image command from the Check 
Routine menu. NeuroCheck stores such images within the check routine to be used for 
adjusting camera positions in automatic operation (see “Adjust Cameras” on page 48).
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To configure the input signal choose Remote Control from the System menu.

Activate Adjust cameras. Select the digital input using Options.

Designate Digital Inputs and Outputs
We recommend to give meaningful names to the inputs and outputs of the bits used 
depending on their function, e.g. “Start check”.
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Renaming is done by in-place editing; choose Device Manager from the System menu. 

Click the “+” icon of the Digital I/O board for the device manager to display all inputs 
and outputs. Now click twice (do not double-click) on the input or output that you want to 
change to enter the desired name. 

Confirm with OK.

1.7.3 Signal Flow Chart for Standard Systems

The system is clocked by an external start signal.
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1.7.4 Signal Flow Chart for High Speed Systems

The start signal is applied constantly and the system triggers itself, thereby achieving the 
highest possible evaluation speed.
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2 Process Optimization and 
Troubleshooting

In this section you’ll learn how to optimize your NeuroCheck visual inspection system and 
how to handle possible problems. 

In detail, you’ll learn

• how to adjust cameras and check that they are connected correctly;

• how to check whether all hardware components are recognized correctly;

• how to check the communication of NeuroCheck with the superior control system and 
its correct integration;

• how to change target values in automatic mode easily;

• what information NeuroCheck provides for troubleshooting purposes;

• how to work through a check routine step by step; and

• what you can do when you don’t find a solution.

2.1 Hardware Check

2.1.1 Peripheral Equipment (Visual Check)
If you encounter problems with your inspection system (e.g. high rate of false alarms), 
first take a close look at cameras, lenses and lighting equipment. 

Check

• Lighting for function and brightness. This is simple when you have a standard 
application with permanent lighting. If your inspection system switches different 
lighting setups, please refer to the specific manual for your system.

• If brightness decreases considerably, clean or replace the light source.

• If lighting fails completely, check the mains power supply and the connections 
before replacing it.

• The plug-in connections on the back panels 
of the cameras.
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• Cameras and lenses for

• damages,

• dirt,

• blocking objects.

2.1.2 Status Bar
The status bar is located at the bottom of the NeuroCheck window. 

It tells you whether necessary hardware components such as security key, frame grabber, 
digital I/O board, serial interface and field bus board are available in the system and have 
been recognized.

The icons stand for (from left to right): security key, camera icon for frame grabbers, 
digital I/O board, serial interface and field bus board. 
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Security key and frame grabber (camera icon) are always required. I/O board, serial 
interface and field bus may be required, depending on the configuration of your inspection 
system. For more information please refer to the specific manual for your system.

• If the dongle icon is missing, the security key is not recognized correctly. For further 
information please refer to „Security Key Test“ on page 45.

• If the camera icon is missing, the frame grabber is either defective or is not correctly 
integrated. Check, as described below, whether the frame grabber has been configured 
correctly in the Device Manager (for more information refer to the user manual or 
contact our technical support).

• The same holds for a missing digital I/O board icon. Either the board is defective or not 
properly integrated. Check, as described below, whether the digital I/O board is 
correctly configured in the Device Manager (for more information refer to the user 
manual or contact our technical support).

• If the depicted icon is missing from the status bar, the serial interface of your computer 
is defective or not properly recognized. Check, as described in the following, the 
configuration in the Device Manager (for more information refer to the user manual or 
contact our technical support).

• If the depicted icon is missing from the status bar, the field bus board of your computer 
is defective or not properly recognized. Check, as described in the following, the 
configuration in the Device Manager (for more information refer to the user manual or 
contact our technical support).

• This icon appears in the status bar when the system was restarted without the security 
key.

Device Manager
The various hardware components necessary for an image processing system are managed 
by a central Device Manager that is similar to the familiar hardware management of 
Microsoft Windows. 
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To check the configuration in the Device Manager, choose Device Manager from the 
System menu.

The appropriate boards and interfaces must be present in the device tree.

To add a new component, click New in the Device Manager. The new component is 
configured through an easy-to-use hardware wizard.

Select the type of component and click Next. In the following dialog select the specific 
model for your application from a list box.
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Clicking Next opens the final page of the
hardware wizard. Your hardware component
is now configured. Click Finish to test it and
integrate it into your system.

2.1.3 Security Key Test
Comprehensive information about the security key can be obtained via the WIBU-KEY 
control panel extension for checking properties of connected security keys.

Open the WIBU-KEY control panel by double-clicking the security key icon in the status 
bar with the left mouse button.

If the security key is not recognized and the corresponding icon not present, click on the 
depicted icon which is displayed instead in the status bar.

The control panel initially displays the Contents page.
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This is where all detected security keys are listed in a tree view sorted by connections. 
Usually there will only be a single security key. If no security key is displayed, there can 
be several causes:

• There is a problem with the driver installation.

• The parallel interface is defective (or blocked by a printer driver; some drivers do not 
behave correctly in this respect).

• The security key is defective (rare, but possible).

Possible driver problems can be checked on page Install. 

The Validate button causes the control panel extension to check for inconsistencies in the 
driver installation and to suggest corrective measures.
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2.1.4 Live Image

Check whether there is a suitable live image available.

Switch to live image mode by clicking the depicted icon. 

If your inspection system includes several cameras, you can select the desired camera 
from a list.

If you cannot get a live image, even if the frame grabber was recognized correctly, check 
the camera setup.

Select the desired camera from the device tree after choosing Device Manager from the 
System menu.

Then click the Properties button. This opens the dialog box for Camera Properties. 

Click arrow to 
open list

Live image
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You can see which camera setup is loaded by checking the Description tab. This must 
correspond to the camera type used in your inspection system. For more information refer 
to the user manual.

If this message is displayed at the bottom of the NeuroCheck window, the camera could be 
faulty.

2.1.5 Adjust Cameras
Next you should check the position of the camera as well as brightness and focus of the 
camera image. 

The Adjust Cameras function is a useful tool to correct misalignment of the camera or to 
adjust brightness and focus. However, there must be a reference image available already.

Choose Adjust Cameras from the Tools menu or click the depicted icon to call the Adjust 
Cameras function. If the input signal Adjust cameras was configured, the function can 
also be activated by this signal (see “Adjust Cameras” on page 37).

adjust 
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With the help of two tabs you can switch between live image and reference image. Using 
the marks in the reference image, you can adjust your camera position in live view. You 
adjust the brightness by changing the f-stop on the lens; here, too, the reference image 
serves as the model. If the image is out of focus, adjust the focus on the lens. 

Both f-stop and focus should be re-
locked after the camera has been
adjusted.

f-stop, aperture

Fixing screw

Focus
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2.1.6 Check Signal Connections
Please make sure that production equipment is stopped when testing the signal 
connections and that the superior control system is in manual mode.

Digital I/O Board
You can check the inputs and outputs of the digital I/O by choosing Test > Digital I/O 
from the System menu.

You can set the outputs by clicking the check
boxes in the Test Digital I/O dialog box and you
can then check at the control system whether the
signals arrive.

You can apply inputs from the control system and
check whether they are displayed in the dialog
box.

Field Bus Board
You can check the inputs and outputs of the field bus board by choosing Test > Field Bus 
Process Mapping from the System menu.
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You can set the outputs by clicking the check boxes
in the Test Field Bus Communication dialog box
and you can then check at the control system
whether the signals arrive.

You can send signals from the control system to the
inputs and check whether they are displayed in the
dialog box.

Serial Communication
You can check the serial interface by choosing Test > Serial Communication from the 
System menu.

In the Output data field you can enter the decimal ASCII codes of characters to be sent by 
NeuroCheck. Separate the individual character codes by spaces. The Send button sends 
the characters via the serial interface. 

The Input data field displays the ASCII character codes most recently received by 
NeuroCheck from the serial interface. Thus you can easily check data transfer in both 
directions.

The dialog box Test of Serial Communication
is displayed. 
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If the result of the check of the signal connections yields no faults and NeuroCheck is still 
waiting for the start signal, you should check whether the correct communication interface 
is selected as the source for the start signal.

Choose Remote Control from the System menu.

Switch to the Input Signals page in the Remote Control dialog box and select Start 
check. Click the Change button to open the Select Signal Source dialog. Check whether 
the correct signal source is selected. 

It must not be set to Manual<ENTER> because in that case NeuroCheck will wait for the 
ENTER key to be pressed to start the check.

If necessary change the settings and confirm with OK.
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2.2 Troubleshooting Tools

2.2.1 System Log Window

The system log window of the automatic screen gives
you a first important hint, which check is reporting an
error.

A red circle with a yellow cross marks the failed check,
in this case Position adjustment.

2.2.2 Error Statistics
Furthermore, the NeuroCheck automatic screen offers you the possibility to have the error 
shares of the individual checks displayed in the result output window. You can also have 
several result output windows with different output categories displayed simultaneously. 

The result output window on the automatic
screen looks like this by default. It shows the
proportional distribution of the check routine
results. 

Usually, there is another result output window
displaying the error shares of the individual
checks. 

If this is not the case, you can have the error
shares displayed as follows:

Switch to Configure Automatic Screen mode. Click the icon depicted on the left.
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Right-click the result output window and choose Parameters. In the dialog now displayed, 
click the arrow to open the list; select Error shares of individual checks.

Confirm with OK.

Switch back to automatic mode by clicking the depicted icon.

Now the result output window displays the error
shares of all individual checks of the check
routine. 

It’s easy to see that in this example the error
share of the individual check Position
adjustment is disproportionately high.

In the following error search, you can
concentrate on this particular individual check.

How to step through an individual check in
manual mode is described on page 66.

In order to reset the statistics, that
means to set the count of inspected
parts back to 0, you can choose the
command Reset in menu Tools >
Statistics
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2.2.3 Debugging Screen
You can also supervise the behavior of a check routine online. Debugging output takes 
time and uses up system resources, which is why you should avoid it in normal operation. 
Since a check routine can manage any number of different screen layouts, you can choose 
a special layout for debugging purposes. If, of course, one has been created at all. How to 
create a debugging layout is described in section „Screen Layouts“ on page 17.

Change into Configure Automatic Screen mode.

Select the debugging screen from the list box.

The Diagnostics/maintenance window lists every
single check function executed during a check routine.
The additional output of error and status codes helps
the NeuroCheck support team to find the reason for
your problem (see “Configuration of Automatic Mode”
on page 12). 

2.2.4 Check Routine Overview
The check routine overview window can be inserted into the bottom left window area in 
manual mode. It gives you a quick overview over important configuration properties of a 
check routine, e.g. the inputs and outputs used, image sources etc.

The window is displayed by right-clicking the empty editing area on the left side and 
selecting the Show Overview command from the context menu. It can be removed by 
selecting Hide Overview from the context menu.

Configure automatic screen
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Alternatively, you can use the Check Routine Overview command from the View menu.

The overview window displays the following properties of the check routine and its 
individual checks: 

Data Output
The overview window displays icons in each line representing the destinations which are 
used for output by functions within the individual check. 

Statistics
The overview window displays the number of the check functions in each individual 
check. 

Digital I/O
The overview window displays which inputs and outputs are used by the functions Read 
Digital Input and Set Digital Output within each individual check. 

Data Sources
The overview window displays the sources for image and classifier data. 

Basically it consists of two elements:
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• A list box from which you can
select the property to be
displayed in the overview
window.

• A list with one line per
individual check displaying the
selected properties.

2.2.5 Protocol File

The protocol file is a very useful tool for solving problems with NeuroCheck start-up or 
automatic operation.

Information about Automatic Operation

The dialog box is displayed by choosing General Options from the System menu.
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For NeuroCheck to generate troubleshooting information during automatic operation, 
switch to the Debug page of the dialog box General Software Settings. Here you can 
make the appropriate settings. 

If the check box Create global log file is activated, system log information such as name 
and activities of the executed check routine, date, time etc. are written into the 
NCLOG.TXT file in the NeuroCheck installation directory. This information can help you 
to locate the cause of problems. 

The View button opens WordPad with the log file so that you can read the log file without 
having to leave NeuroCheck.

You can delete the log file by selecting Delete.

Important:
Creating log files uses additional computer resources. This increases the execution time 
required for the visual inspection. Depending on the application, this can be a problem 
with short cycle times. We recommend to generate log files only when troubleshooting is 
necessary.

Clicking the Options button opens another
dialog, in which logging mode and log file
format can be selected.

The warning level and the maximum size
for the file can also be selected. When the
file reaches this size, NeuroCheck
overwrites the file again.

Information about Start-up Behavior
The following function uses the same file as the above mentioned logging of automatic 
mode. 

Using the command line option /LOGFILE, the start-up behavior of NeuroCheck can be 
logged. The protocol file NCLOG.TXT in the installation directory records not only the 
current date and time, it also informs you whether the dongle and the correct license level 
were recognized and whether drivers and plug-in DLLs were loaded correctly.
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The command line option can be given in the properties window of the NeuroCheck 
shortcut on the desktop or in the application folder of the Start menu. 

From the context menu (right mouse button) select Properties; in the properties window 
go to the Shortcut page; and in the Target field add the command line option /LOGFILE. 

NeuroCheck reports the system start-up in the log file.

For more information on this subject refer to the appendix of the NeuroCheck Training 
Course. 
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2.3 Software Optimization

2.3.1 Changing Target Values

NeuroCheck enables the user to change published target values or to add or change 
measurements. How to publish target values is described in chapter „Data Integrity for 
your System“ on page 79.

Changes in the production process can thus be accommodated by optimizing the target 
values for certain functions without having to change the processing parameters 
themselves. To facilitate easy changes in such cases target values can be set directly in 
automatic mode. This is also possible in the runtime version of NeuroCheck. 

Such changes should only be made by trained personnel.

By clicking the depicted icon in automatic mode, you can open the dialog for entering 
parameters and target values.

The parameters that can be set here relate to the check function Define ROIs from our 
example check routine (see appendix). By selecting the appropriate function, e.g. the x-
direction of the ROI, the parameter value can be changed in the text field. Clicking the 
Apply button causes the new values to be used. 

All check functions whose parameters and target values are published can be accessed 
using the tabs. Use the two arrows to browse the tab pages.

Please note that the possibility of parameter/target value input here can also depend on the 
current user profile. If your user profile does not permit changing of target values, the 
corresponding icon is disabled. For more information see “Security Profiles” on page 80.

parameter/target value input
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2.3.2 Error Images

NeuroCheck makes it possible to save error images directly from the running process. The 
error images can be used to optimize the system and to reduce false alarms by loading 
them as bitmap files into the check routine. 

With these images you can then determine why a check failed and thereby find out 
whether it is really a false alarm or a problem in the manufacturing process. 

Saving Error Images
A prerequisite for working with error images is that these images are saved. Saving of 
error images is usually activated by default. 

Depending on the application, this can exceed the allowed inspection time, since saving 
images requires time and thereby extends the overall duration of the inspection. In such 
cases, we recommend activating the saving of error images only when you want to do 
troubleshooting or optimization.

To activate the saving of error images, proceed as follows: 

Right-click the appropriate check and select Properties from the context menu. 

Alternatively choose Properties from the Edit menu.

A dialog box appears.

Click the Error Documentation page. 

Activate the check box Save Image and select the check function that generates the image 
to be saved. Usually this is Transfer Image. 
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In the next field, enter the number of error images to be saved. This cyclical buffer can 
store up to 999 images. Select a number that suits your requirements (usually no more than 
99 images)

Use Browse to determine the directory in 
which to store the error images. 

We recommend to create a path 
Images\Errorimages in the 
NeuroCheck standard-directory.

Loading Error Images
To load error images, switch into manual mode by clicking the depicted icon and open the 
appropriate individual check by clicking the “+” symbol. 

By clicking the depicted icon, NeuroCheck is instructed to ignore all functions that expect 
signals via digital I/O. That way, inspection applications that are remote controlled via 
digital I/O can easily be edited without needing the whole manufacturing process 
including the PLC to create the necessary signals.

Select check function Transfer Image by clicking and open the corresponding parameter 
dialog by selecting the depicted icon.



Process Optimization and Troubleshooting 63
Select Bitmap file, then click Browse. Select the corresponding bitmap files from the error 
images folder.

You can select files individually

or in groups. 

You can select the error images as a group by left-clicking the first file (in this example: 
demo_pqi0.bmp) and then left-clicking the last file (in this example 
demo_pqi19.bmp) while holding down the Shift key.

Leave the dialog box with OK.

If several error images are selected, they are processed cyclically, i.e. every time you click 
Execute Check Function, the next error image is loaded. To make identification of the 
error images possible, the name and path of the file are displayed above the result output 
area.

NeuroCheck offers you the possibility to switch the image sources of all functions 
Transfer Image from camera images to bitmap files using the Simulate Image Capture 
command. This way especially applications using several cameras can be easily edited. 
Execute this command by clicking the depicted icon. Then the bitmap files are loaded 
whose path was entered last.
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Select the first check function and execute it using the depicted icon.

Single-step through the check functions using the icon depicted here.

How to step through a check routine manually with the loaded error image, is described in 
detail in „First step:“ on page 66.

Back to Automatic Mode
In manual mode you carried out the check routine step by step using the loaded error 
images. Now you want to switch back to automatic mode. Before doing so, make sure that 
the image source is switched from Bitmap File to Camera.

For this select the check function Transfer image and open the corresponding parameter 
dialog using the depicted icon.

Choose Camera as image data source and close the dialog with OK.

In case you activated the Simulate Image Capture command, deactivate it by clicking the 
corresponding icon again.

This is very important because otherwise the system does not use the live image in 
automatic mode but an image from a bitmap file.
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Click the depicted icon to suspend the Ignore I/O function.

Now you can switch to automatic mode. 

If the following safety hint is displayed, the image source is still set to bitmap file for at 
least one check function.

Click No and make the changes described above. 

Especially for applications that use more than one camera, the overview window is 
extremely helpful to find the function whose image source is still set to Bitmap (see 
“Check Routine Overview” on page 55).
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2.3.3 Troubleshooting Using the Check Routine 
Example

Here we will give an exemplary explanation of troubleshooting using the check routine 
described on page 29.

Let us assume the connector plug check routine issues the following not O.K. message:

A visual inspection of the plug does not yield any faults. It must be a false alarm.

First step: 

Go through the check routine in manual mode step by step.

To find the reason for the error, click the depicted icon to switch into manual mode. 

In the check function Transfer Image load the error images (as described in the previous 
chapter). Select the first check function and execute it using the depicted icon.

Single-step through the check functions using the icon depicted here.
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Back to the example: 

Transfer Image

Here you can already see that the input image is very bright and has low contrast. Let’s 
step through the next check functions to understand what is happening.

Enhance Image 

Here you can see that the plug pin on the bottom left is only discernible as a small white 
dot.
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We’ll skip the following three check functions since they are not relevant to our search for 
the error cause.

Create ROIs by Thresholding

In this check function the white dot is no longer identified as a plug pin and therefore no 
longer taken into account in the following check function.

Count ROIs

Of course, here a wrong number is then determined.
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Second step: Adjust Cameras Function
In the next step of the troubleshooting procedure compare the stored reference image with 
the current live image using the Adjust Cameras function.

Click the depicted icon as previously explained in Adjust Cameras.

The comparison between reference and live image clearly shows that the live image is 
correctly positioned, but it is far too bright.

In this example the f-stop setting of the
camera should be adjusted to solve the
problem.

Reference image

Live image
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2.4 Hotline, Web site 
If you cannot find a solution for your problem, NeuroCheck technical support is at your 
disposal both on the phone and over the Internet. 

NeuroCheck Technical Support:
Phone: +49 (0) 711 22 96 46 31 

Fax: +49 (0) 711 22 96 46 59
E-mail: support@neurocheck.com

http://www.neurocheck.com

For optimum support, please provide us with the complete version number of your 
NeuroCheck installation first. 

You will find this information by choosing About NeuroCheck from the Help menu or by 
clicking the depicted icon.

The more detailed the information you can give us about your problem, the faster and 
more efficient the support we can give you. For example, creating a Protocol file is a very 
useful tool for solving problems with NeuroCheck start-up or automatic operation (see 
“Protocol File” on page 57).

If you have stored images pertaining to your problem, please include them with your 
check routine in your E-mail, preferably packed into a ZIP archive. 
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2.5 Remote Maintenance
We offer remote maintenance as an additional option. This requires the necessary software 
to be installed on your computer. We can then log on to your system over a phone line and 
solve your problem in situ. In this way, expensive and time-consuming service can often 
be avoided.
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3 Getting Help on NeuroCheck 

In this section, you will learn about other sources of helpful information available to you 
besides this setup manual and how to access them.

3.1 Online Help
Even the best user interface cannot answer every question; therefore, a comprehensive 
online documentation is especially important for an area as specialized as digital image 
processing. NeuroCheck saves you the time to look for answers in voluminous manuals by 
providing an online help system that makes the required information instantly available to 
you. 

Online help is automatically installed together with the NeuroCheck program. Updated 
versions are available for download from http://www.neurocheck.com. 

Accessing Online Help
In NeuroCheck you can access helpful information in various ways.

Choose Help Topics from the Help menu to access the hierarchical help contents and the 
searchable index. 
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From there, you can reach all
explanations and function
references. You can browse
through every chapter of the help
system as though it were a book
by using the appropriate buttons.
Overview pages are another
structural level above this
reference information and help
you to get to the desired
information quickly.

Many times you can obtain the help needed at that moment even more directly.

Help information for each element of the NeuroCheck user interface can be reached by 
clicking the depicted context help symbol, followed by a click on the user interface 
element in question.

Help for Specific Parameters
Probably the most important way to access help information can be found in the dialog 
boxes, where settings for NeuroCheck as a whole and for individual image processing 
functions are made. Click on the question mark in the upper right corner of the title bar of 
the dialog box. 

The mouse pointer changes into a context help cursor. With
this help cursor, click on the control element for the parameter
in question. As a result a small pop-up help window appears
with a short explanation for the control element. It will
disappear again when you carry out the next action in
NeuroCheck, so you can continue to work as usual.

This way you can look up the meaning of each parameter without having to read a full-
length explanation of the function in the online help or manual again.
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Function Descriptions
A helpful tool for the understanding of check routines is the function description of check 
functions. In manual mode, select a check function in the edit area and choose Info from 
the Check Function menu. You’ll reach the same explanation when you right-click the 
function in the check routine window and choose Info from the context menu.

A help window appears with a complete description of the function with all its parameters. 
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3.2 Frequently Asked Questions

To complement the numerous information and help topics in the manual and the online 
help of NeuroCheck, there is a collection of frequently asked questions (FAQs) from users 
of NeuroCheck. 

You can access this collection by choosing FAQ from the Help menu.

This collection of questions and answers contains tips and solutions for typical hardware 
and software problems that can help you in similar cases.

Our Web site (http://www.neurocheck.com) provides you with an up-to-date version of the 
FAQ collection that you can download at any time or read online (NC_FAQ_e.html). 
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3.3 Additional Information Sources
There is even more information about NeuroCheck. This page gives you an overview as 
well as a short description of each information source to help you choosing the appropriate 
one. If you are unable to locate the information you are looking for or have special 
questions, please contact your NeuroCheck dealer or the NeuroCheck GmbH (Web site: 
http://www.neurocheck.com).

 

Readme
The Readme file contains helpful hints for installing and making your first steps with 
NeuroCheck.

You will find a Readme.txt and Readme.pdf in the root directory of the NeuroCheck 
CD-ROM. 

Getting Started
This short manual gives an overview of the functionality of NeuroCheck and its 
application areas, describes the installation, and contains a tutorial on the configuration of 
check routines.

You will find the file Getstart.pdf in the Extra\Documentation directory on 
the CD-ROM; you can also download it from our Web site (http://www.neurocheck.com). 
A printed copy is included with every NeuroCheck edition. 

Training Course
The Training Course gives a step by step introduction into configuring check routines for 
different application areas.

A printed copy is included with the NeuroCheck Professional and Premium Edition. 

Industrial Image Processing
The book “Industrial Image Processing” provides you with a practical introduction into 
image processing. It focuses on the combination of procedures in an integrated image 
processing system. Using real life examples and utilizing the NeuroCheck software, it 
gives an introduction to the automated solution of industrial inspection tasks.

Published by Springer Verlag (Berlin, Heidelberg, New York), ISBN 3-540-66410-6. Also 
available in German. 
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Industrielle Bildverarbeitung
The book on visual quality control; also available in German! ISBN 978-3-642-13096-0

User-Manual
The user manual gives a detailed description of all NeuroCheck functions.

A printed copy is included with the NeuroCheck Professional and Premium 

Edition. 

Programmer's Reference
The Programmer’s Reference addresses primarily software developers and explains how 
to extend NeuroCheck with plug-in functions and self-developed communication drivers 
and how to control it via OLE automation.

You will find the file ProgRef.pdf in the Extra\Documentation directory on the 
CD-ROM; alternatively you can download it from our Web site (http://
www.neurocheck.com). A printed copy is included with the NeuroCheck Premium and 
Professional Edition. 
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4 Data Integrity for your System

In this section you will learn

• how to protect your inspection system from unauthorized access and how to make it 
accessible for authorized personnel only,

• what features NeuroCheck provides for saving your data.

4.1 System Integrity
NeuroCheck contains several security options. 

• With the help of Password Protection it is possible to protect the check routine from 
unauthorized access.

• With its comprehensive User Profile System, different access authorizations can be 
granted. This controls who is authorized to make changes. 

• NeuroCheck enables the user to change published target values or to add or change 
measurements.

4.1.1 Password Protection
Open the dialog box for password protection by choosing Password Protection from the 
Check Routine menu. 

It allows you to enter a password for the active check routine or to deactivate password 
protection. A check routine protected by a password cannot be saved, i.e. the version 
currently stored on the data carrier is protected against changes.
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When password protection is deactivated, the
dialog box contains two text fields. The new
password is entered in the text field Password.
For security reasons the characters of the
password are displayed as asterisks. Then the
password has to be confirmed by entering it again
in the text field Confirmation. Only after correct
confirmation the OK button will be enabled.

When password protection is active the dialog
box displays only the text field Password. By
entering the correct password and confirming
with OK, password protection is deactivated. The
OK button will be enabled only if the correct
password has been entered.

4.1.2 Security Profiles
In addition to protecting individual check routines by using the password protection 
dialog, NeuroCheck offers you the possibility to set up any number of user profiles. The 
system administrator can set access authorizations for each user profile, thereby disabling 
certain program functions. This system allows OEMs or production supervisors to protect 
their installed applications against any unauthorized use.

Structure of the Security Profile System
For maximum security the system of security profiles is managed through a combination 
of dongle programming and a password file. The fact itself that a NeuroCheck installation 
is password-protected is encoded in the dongle, the current passwords and the access 
authorizations are stored in a password file in the NeuroCheck directory. 

Establishing a Security Profile System
To set up security profiles choose Security Profiles from the System menu.
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The first dialog box appears.

Select Add to create the first security profile.

Note that at least one security profile needs to own system administrator rights to make 
adding, editing or removing security profiles and passwords possible. 

Therefore, you will first establish a system administrator profile. Choose any name. The 
check box System Administrator must be active. 

For security reasons, the password has to be entered twice (all password dialogs are case 
insensitive). 

On the following pages access authorizations are granted. The system administrator can 
determine the authorization for each user profile (for details refer to the user manual).

On the last page of the Security Wizard dialog, a system administrator can activate logging 
of actions carried out under the current security profile. Format and extent of the data to be 
logged is set in Options. 

Add more security profiles by selecting Add. Make sure that the check box System 
Administrator is only activated for the person responsible and other authorized people. 
Deactivate the check box for all other users.

Start-up Procedure of a Protected Installation
When starting NeuroCheck, the stored security profiles and their passwords are read from 
the dongle. Then the most recently used security profile is activated. This ensures that no-
one can enter a different security level without having the correct password.
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Removing System Password 
Protection
Leaving the Security Profiles dialog while no
security profile is activated in the list view
removes password protection. The dongle is
reprogrammed. Only a system administrator
has the right to do this.

Switching Security Profiles
The current security profile can be changed by selecting a new profile from the list box in 
the Extra toolbar. 

Depending on the access rights of the new security profile this may involve a change of 
operating mode (for example: if the security profile is switched in manual mode and 
manual mode has is not allowed for the new profile, NeuroCheck will enter automatic 
mode). Unless the current user has system administrator rights the Security Profile 
Password dialog asks for the password for the new profile.

4.1.3 Publishing Target Values
To accommodate changes in production easily, target values must be published for editing 
in automatic mode. If this was not already done during application development, the 
system administrator can publish the target values as follows:

To publish target values choose Data Input > Parameters/Target Value Input 
Configuration from the Check Routine menu.
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Select those check functions in the dialog box Parameter/Target Value Input 
Configuration whose target values are to be accessible in automatic mode and click 
Publish.

Now select those data elements that you want to publish. 

In addition you can enter a text and comment. This can be helpful later on for the operator.

Note: The above mentioned steps are only possible when publishing the target values has 
been allowed for the current security profile in the security wizard reached from the 
Security Profiles dialog (see section above). 
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4.2 Saving Data

4.2.1 File Output
Wherever it is useful, NeuroCheck functions allow for writing result data to files. This 
includes both measuring data and check results; the output data can be specified for each 
function separately. Thus NeuroCheck meets the requirements of modern quality 
management for comprehensive inspection records.

To configure the output of result data into a file, you have to switch to manual mode by 
clicking the depicted icon.

Choose Data Output > File from the Check Routine menu.

On the first page you select the basic file format. The preselected CSV (comma separated 
value) format is a standard data exchange format understood by most spread-sheet 
programs, e.g. Microsoft Excel.

Simply click Next here.

Activate the check box Generate File
Output in the File Output Settings dialog
box. Now the other buttons are active.

Click Settings.
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In the output mode dialog you can choose between a single output file or a series of files. 
The default setting is Write Single Output File. Select the desired setting and click Next.

Click the Browse button in the next dialog.

A file selection dialog box appears. Here
you can enter the name and path of your
output file. The output file can be on any
storage medium, also on a network drive.
Leave the dialog with Open.

Click Next to open the dialog for the
commentary entry. If you activate the
check box Write additional information
as file header comment, you can enter a
commentary into the text field that will be
written at the beginning of a file for easier
identification. 

After leaving the wizard with Finish, the File Output Settings dialog will display the 
select file name – possibly abbreviated – and the file format.
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Click the Output format button to open the dialog box File Output Format to set format 
options.

It contains two tabs to set various aspects of the result value output format:

Check Result: This page sets options for the output of check routine and individual check 
results.

Payload Data: This page sets options for the output of the results from individual check 
functions.

This dialog is opened by clicking Options
in the File Output Settings dialog. It
allows you to enter settings for the global
control of data output into files, such as
whether a record is written for each
inspection cycle or only when there is an
error, or to limit the file size. 

Data Output of Check Functions
Data output of individual check functions is activated on the Data Output editing page. By 
clicking the depicted tab, you can switch to the appropriate page.
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Data output is activated globally by the steps
described above. Now you can select the data
output for the various check functions by
clicking the check boxes.

The output of a bitmap file is also possible. For
this select Destination: bitmap file globally
and then Bitmap file at the Transfer Image
check function. 

The following dialog box appears:

Enter the desired path with Browse and
confirm with OK.

4.2.2 Serial Data Communication
Similar to logging inspection data to a file, NeuroCheck allows the output of result data 
via serial interface using a fully documented protocol with error detection by check sum or 
CRC-32.
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Open the Serial Output Settings dialog box by switching to manual mode and choosing 
Data Output > Serial Interface from the Check Routine menu.

If Generate Serial Output is activated, result values will be sent over the serial interface. 
A prerequisite is that the serial interface is registered in the device manager (see “Device 
Manager” on page 43).

Using Options you can select additional information to be added to the result values of the 
check functions during transfer (for further information please refer to the user-manual).

For information about data format, test and configuration of the serial interface see „Serial 
Communication“ on page 51.

4.2.3 Custom Communication Interfaces
The NeuroCheck custom communication interface provides functionality similar to the 
serial interface. This functionality is implemented by means of a DLL driver typically 
provided by the supplier of the communication device. For more information on the 
custom communication interface, please refer to the Programmer's Reference. 

4.2.4 Disc Image
Using disc imaging (Drive Image), you can store a compressed image of an entire hard 
disk or of individual partitions on CD-ROM. In case of data loss, the image file can be 
used to recover and restore data. Thus a disc image is an ideal backup medium to quickly 
and safely restore data lost because of a damaged hard disk.
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4.2.5 Uninterruptible Power Source (UPS)

Optionally, an uninterruptible power source can be installed into the system computer to 
prevent data loss due to power failures. 

In case of under voltage or power failure, the UPS supplies power to the system.

During regular power supply operation, internal filters serve as mains overload filter and 
effectively prevent damage because of power surges. This way the destruction of 
important data as well as damages to the hardware can be avoided and system lifetime is 
prolonged.

In case of excess temperatures (more than 105° C), the internal temperature control raises 
an alarm by activating the red excess temperature LED and giving an acoustic signal.

When the computer is started, the UPS is activated automatically, and when the computer 
is switched off, the UPS switches itself off within 3 seconds.

UPS Management Software
The installed UPS management software causes a warning to be displayed on the screen in 
case of power failure; open files are automatically saved. After automatic saving is 
completed, the UPS switches off.
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5 Maintenance and Care

5.1 Maintenance Instructions

Every other week
Check for pollution:

• Lens

• Lighting

If required, clean with oil-free pressurized air or special lens cleaning cloth.

Every four weeks
Check for good fixation (handle carefully, especially with coarse tools!):

• Camera

• Lighting

Afterwards, check correct position with the help of the Adjust Cameras (see “Adjust 
Cameras” on page 48) function.

Every other month
Check for pollution:

• Dust filter of PC fan

5.2 Service Pack
The service pack is a program that updates the NeuroCheck version on your computer. It 
fixes bugs and provides new functionality. You can download the service pack free of 
charge from our web site at any time.
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5.3 Update
Software can never really be “finished”, there are always new ideas and extensions. 
Therefore, the latest version of NeuroCheck is always available on our web site. Please 
note that version 5.1, for example, does not accept a dongle of version 5.0 or earlier. For an 
update, the dongle has to be re-programmed. Please contact NeuroCheck GmbH or your 
NeuroCheck dealer for details regarding an update to a newer version.

5.4 Upgrade
An upgrade from a lower to a higher license level is possible at any time. For example, you 
can upgrade a Runtime Edition to a Professional or Premium Edition.
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6 Appendix

This appendix provides you with information about complete hardware setups as well as 
individual hardware components, and contains a checklist for troubleshooting as well as 
an exemplary check routine.

6.1 Standard Industrial PC

Standard industrial PC in 19“ housing 
with external monitor.

Housing measurements (W x H x D): 

560 x 370 x 600 mm
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Typical back panel of a 19” industrial PC

6.2 Compact Industrial PC

Industrial PC in a compact housing
(protected according to German
IP65 standard) with integrated TFT
monitor as stand-alone solution.

Housing measurements (W x H x 
D): 520 x 480 x 260mm

keyboardmousepower dongle

monitor camera

digital
inputs

digital
outputs

field busback panel
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6.3 PC Camera

The PC camera has an integrated processor; thus it is a PC and camera in one. Because of 
the simple setup with highly integrated standard PC components, it provides a compact 
and reliable solution for visual inspection tasks. 

Applications can be developed on a standard PC and easily transferred to the PC camera. 
It is also possible to develop the application directly on the PC camera.

The PC camera has an interface for peripheral equipment such as monitor (the PC camera 
can be operated without a monitor), keyboard and mouse. Both parallel port and network 
connection are provided. A digital I/O is provided with eight electrically decoupled inputs 
and outputs each to control external processes. 

The PC camera contains an integrated network interface card. Both communication and 
data backup can be realized in a convenient way.

By default the system has a camera resolution of 640 x 480 square pixels. Higher 
resolutions up to 1280 x 1024 pixels are available upon request.

6.4 Digital I/O Board

The digital I/O board offers 16 digital inputs and 16 digital outputs; inputs and outputs are 
electrically insulated by means of opto-couplers. All opto-coupler inputs and outputs also 
have TAZ diodes as protection against power surges. The output opto-couplers are 
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connected to the 37-pin D-sub connector mounted on the slot cover of the board itself. The 
input opto-couplers are connected to a header connector on the board; from there, a ribbon 
cable leads to another 37-pin D-sub connector on a separate slot cover.
 
 

6.5 Field Bus

The field bus board is used to connect different stations or work cells on a manufacturing 
line or in an entire plant. 

NeuroCheck is integrated into your manufacturing process via PROFIBUS-DP.
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6.6 Frame Grabber

The frame grabber is the interface to the video camera. The image is read from the camera 
and stored until it is read by the image processing program.

NeuroCheck supports simultaneous operation of as many frame grabbers as the number of 
PC slots allows. Frame grabbers can be of different types and from different 
manufacturers, e.g. in order to use line-scan cameras, analog area scan and color cameras 
at the same time.

6.7 Cameras

The following camera types are available:

• Video cameras according to CCIR/EIA standard for non-moving parts. 

• Triggered progressive scan cameras for parallel image capturing and processing in 
high-speed systems. 

• Line-scan cameras for large or rotating objects. 

• Digital area-scan cameras for high-precision measuring. 

• Color cameras (PAL/NTSC). 

• FireWire-Cameras (IEEE 1394)
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All connected cameras can be individually named. These names are used throughout the 
program; it is therefore not necessary to remember that the camera showing the right side 
of the spark plug on the fourth cylinder is connected to the second input of the first frame 
grabber. Instead, the camera is simply given an appropriate name. Furthermore, a separate 
reference image can be stored for each camera. These reference images are used to adjust 
the system in automatic mode.

If the frame grabber allows the setting of input parameters, these can be saved in a camera 
setup file, which can be exchanged among NeuroCheck installations. Camera setup files 
can be easily documented when they are written out as text files.

6.8 Dongle and License Levels

The license level is encoded in the security key
(dongle). It is connected to the parallel interface
(printer port) of the system computer.

The following editions or license levels of NeuroCheck are available:

Premium Edition 
The Premium Edition provides complete functionality for configuring check routines in 
manual mode and full hardware access, i.e. several cameras, digital and serial 
communication. In addition, the Premium Edition offers extensibility by plug-in functions, 
custom communication interface drivers and OLE automation. The Premium Edition can 
be protected against unauthorized use (see section „Security Profiles“ on page 80 for 
details).

Professional Edition 
The Professional Edition is identical with the Premium Edition with the exception that 
check routines with plug-in functions cannot be configured. The Professional Edition can 
load and execute check routines with plug-in functions, but it cannot create them.
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Runtime Edition 
The Runtime Edition is intended for the duplication of completely configured inspection 
applications. It has complete image processing, hardware access and extension 
functionality, but restricts operation to automatic mode. No configuration of check 
routines or system parameters is available in a runtime version. Reconfiguring a check 
routine requires exchange of the runtime security key against a Professional or Premium 
security key and restarting the software. To buy a Runtime Edition, you must own at least 
one Professional or Premium Edition.

Demo
NeuroCheck automatically runs as a demo version when the security key is removed. In 
this version, no hardware access is possible. There is no communication, remote-control 
or extension functionality. This version is intended for evaluation purposes only. Regular 
use of a demo version in an image processing laboratory or in an automated visual 
inspection system is illegal. Utilization of results obtained by using a demo version in a 
technical or scientific publication other than a software review violates the copyrights of 
NeuroCheck GmbH.
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6.9 Troubleshooting Check List
This section can serve as a check list for troubleshooting. It summarizes chapter „Process 
Optimization and Troubleshooting“ on page 41 in a shorthand fashion and is intended as 
an on-site memory aid for setup personnel after studying this entire manual. It is also 
available electronically as a PDF file on the NeuroCheck installation CD-ROM and can be 
downloaded from our web site. We recommend having a hardcopy of this check list ready 
to hand at the visual inspection system. 

Hardware Inspection

Visual inspection of cameras, lenses and lighting
Check

• Lighting for function and brightness. 

• Connectors on the back panels of the cameras. 

• Cameras and lenses for

• damages,

• dirt,

• blocking objects.

Status Bar

Check the status bar. You’ll find it on the bottom of the NeuroCheck window. It tells you 
whether the necessary hardware components are available in the system and have been 
recognized. 

The icons indicate:

• Dongle

• Image processing board (frame grabber)

• Digital I/O board

• Serial interface

• Field bus board
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Security key and frame grabber (camera icon) are always required. I/O board, serial 
interface and field bus may be required, depending on the configuration of your inspection 
system. 

Live Image
Check whether there is a suitable live image available.

Adjust Cameras
• Adjust camera position using the marks in the reference image.

• Adjust brightness by changing the f-stop setting on the camera lens.

• Set the focus using the focus ring on the lens.

• After adjustment, re-lock f-stop and focus.

Check signal connections
Please take care that: 

• Production equipment is at stand-still during testing,

• Control system is in manual operating mode.

Check inputs and outputs of digital I/O and/or field bus board by choosing Test from the 
System menu and selecting the appropriate board.

• Set outputs: click the check boxes in the dialog to set outputs. Check transmission of 
the signals on the control system.

• Check inputs: set inputs from the control system. Check in the dialog box whether 
they are recognized.

You can check the serial interface by choosing Test > Serial Communication from the 
System menu.

• In the Output data field you can enter characters to be sent by NeuroCheck as decimal 
ASCII values. 

• The Input data field displays the ASCII character codes most recently received by 
NeuroCheck from the serial interface. 

Signal Source
Check whether the signal source for the start signal has been set to the correct 
communication interface.

Choose Remote Control from the System menu.

• Select Start check on the Input Signals page in the Remote Control dialog box. 
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• Click Change and check whether the correct signal source is selected. 

Troubleshooting Tools

System Log Window
In automatic mode, this window displays the following information:

• Green check mark: individual check successful.

• Red circle with yellow cross: individual check failed.

Error Statistics
The result output window can display the failure share of the various individual checks.

Change into Configure Automatic Screen mode. 

• Right-click the result output window.

• Choose Parameters. 

• Select Error Shares of Individual Checks from the list.

• Confirm with OK.

Switch back to automatic mode by clicking the depicted icon.

Debugging Screen
The Diagnostics/maintenance window lists every single check function executed during a 
check routine.

• Change into Configure Automatic Screen mode.

• Select the debugging screen from the list box.

Check Routine Overview
The check routine overview window can be inserted into the bottom left window area in 
manual mode. 

• Right-click the empty edit area on the left.

• Select Show Overview from the context menu (the overview window can be removed 
with the Hide Overview command.).

Protocol File
The protocol file is a very useful tool for solving problems with NeuroCheck start-up or 
automatic operation.

• Choose Options from the System menu.

• Switch to the Debug page of the dialog box. 
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• The View button opens WordPad with the current log file (see „Protocol File“ on 
page 57 of the Operator Manual for information about configuring NeuroCheck to 
create a log file).

Software-Optimization

Changing Target Values
To optimize inspection system performance, you can change target values directly in 
automatic mode. Such changes should only be made by trained personnel.

Loading Error Images
• Configure NeuroCheck to ignore all functions expecting digital I/O signals.

• Switch to manual mode and display the structure of the individual check in question by 
clicking the “+” icon. 

• Select check function Transfer Image by a single left mouse-click and open the 
corresponding parameter dialog.

• Select Bitmap file, then click Browse. Select the corresponding bitmap files from the 
error images folder. Leave the dialog box with OK.

• Select the first check function and execute it using the depicted icon.

• Single-step through the check functions using the icon depicted here.

Important:
Before switching back to automatic mode:

• change the image data source back from Bitmap file to Camera and 

• switch off the Ignore Digital I/O functionality.

NeuroCheck Technical Support:
Phone: +49 (0) 711 22 96 46 31 

Fax: +49 (0) 711 22 96 46 59
E-mail: support@neurocheck.com

http://www.neurocheck.com
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Maintenance Instructions

Every other week
Check for pollution:

• Lens

• Lighting

If required, clean with oil-free pressurized air or special lens cleaning cloth.

Every four weeks
Check for good fixation (handle carefully, especially with coarse tools!):

• Camera

• Lighting

Check correct position using the Adjust Cameras function (see “Adjust Cameras” on 
page 48).

Every other month
Check for pollution:

• Dust filter of PC fan
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6.10 Check Routine Example
Now we want to go through a simple check routine step by step to describe the function of 
the check functions and the pertaining parameter setting in an exemplary fashion.

We’ll use the inspection of a plug that is tested for the presence of the contact pins.

Transfer Image

The first check function transfers an image into the memory of the computer. Only there 
the image can be processed thus this function is a prerequisite for the use of most check 
functions in NeuroCheck.



106 NeuroCheck Operator Manual
Enhance Image 

Since the input image used has but poor contrast, the check function Enhance Image is 
used to improve contrast.

Display Options
A closer look at the right window pane of the NeuroCheck window will reveal a double 
frame on top. Keep the left mouse button pressed and pull the frame border down. Now 
you’ll see the original input image on top and the enhanced image on the bottom. Above 
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each window area is a bar with control elements for setting display options and zoom 
levels for the window area. 

This option is intended to compare between the original input image (poor contrast) and 
the enhanced image.

Parameters of Enhance Image
The parameter dialog of the function is opened by choosing Parameters from the Check 
Function menu or by clicking the depicted icon when the Enhance Image function is 
selected in the tree view.

The function makes it possible to improve the contrast of different image areas in relation 
to lighting changes. Since the image in our example is rather uniform, an integration area 
over the entire image was created by clicking the Full Image button.

The enhancement is then carried out evenly over the entire image.
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Define Regions of Interest

Here the image section to be used for further analysis is determined.

Because of the importance of the ROI concept in NeuroCheck, this is one of the central 
functions. 

Parameters of Define ROIs
Choose Parameters from the Check Function menu or click the depicted icon when the 
Define ROIs function is selected.
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The parameter dialog has the following elements

Graphics Panel
Here you can define the individual regions of interest using the mouse. In select mode you 
can edit the ROIs using the context menu (right mouse button).

Rectangle
Activates rectangle mode; in this mode you can define any number of rectangular regions 
of interest in one operation.

Polyline
Activates polyline mode; in this mode you can define any number of arbitrarily shaped 
polygonal regions of interest in one operation. 

Select
Activates Select mode; in this mode you can activate defined ROIs using the left mouse 
button and edit them using the context menu. Selection can also be performed using the 
spin buttons to the right.

Group Numbers
This activates the grouping feature of NeuroCheck. In subsequent image analysis 
functions, individual parameters can then be set for each of the defined ROIs. 

Determine Threshold

This function sets a threshold for segmenting background areas and objects. This is a 
prerequisite for using function Create ROIs by thresholding. 
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You’ll notice that all intermediate brightness levels are gone from the image. Executing 
the function removes all gray shades from the image, leaving only black and white areas.

Parameters of Determine Threshold

In our example, the pins contrast well with the background. Therefore, a simple 
thresholding operation will suffice to isolate the objects in the image. First, a threshold 
value must be calculated to be used for this distinction. 

Automatic Computation
Most of the default parameters of this function are well-suited for the task at hand; 
therefore, only one parameter setting was changed. 

This function determines the optimum threshold from the image content within the 
existing ROIs. 

Manual Input
If this option is selected, a global threshold can be entered manually.

Threshold
Sets the manual threshold.
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Create ROIs by Thresholding

Looking for the Plug Area

This function creates new regions of interest starting from existing regions of interest by a 
thresholding process. The existing regions of interest are thresholded and searched for 
objects. From the detected objects a new list of regions of interest is created, that can be 
processed further. 

We can now isolate the pins as objects from the image scene. To guarantee an exact 
recognition when the position of the check piece in the image varies, we search for the 
dark area, in which the pins are located, first. 
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Parameters of Create ROIs by Thresholding

The parameter settings in this dialog have been set in such a way that the largest dark 
object is created within the given ROI. 

Aside from the parameters set here, the object search is influenced by the threshold 
computed by function Determine threshold. An important factor is the required contrast. 
If the difference between minimal and maximal gray level inside a region of interest is 
smaller than this value, no object is detected, even if the thresholding would have 
separated an object from the background. This helps to avoid that a slight disturbance is 
accepted as an object, which in fact is missing.   
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Create ROIs by Thresholding

Looking for Contact Pins

Objects as Regions of Interest
Here you are introduced to one of the most important features of NeuroCheck which is 
crucial for the system’s flexibility. Every object found or computed by NeuroCheck can be 
used as a new ROI. This means that NeuroCheck now uses the dark plug area just found as 
the area in which to look for contact pins. This link is made automatically. Therefore, the 
function Create ROIs by Thresholding is added once more and light objects are looked 
for next.

Therefore, the function Create ROIs by Thresholding appears twice in immediate 
sequence.



114 NeuroCheck Operator Manual
Parameters of Create ROIs by Thresholding

Search Parameters
Light is chosen as Object Color. It is important that Object Generation is set to Limited so 
that the search is only conducted within the defined ROI. Using All Objects for Object 
Selection causes the system to search for all pins.

Click on the Options button; the search ray distance is set to 1. The pins are rather small 
objects that are not located on a precisely horizontal line because of the slight inclination 
of the plug. If the search ray distance is larger, NeuroCheck could miss some pins.
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Count Regions of Interest

This check function counts the number of regions of interest in its input list and compares 
it to a prescribed range. 

The minimum and maximum target values are entered via a target value dialog.

Open the target value dialog by clicking the depicted symbol or by choosing Target 
Values from the Check Function menu.
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The dialog contains the following elements:

Verify
When this check box is activated the function acts as a decision function, i.e. it compares 
the number of existing ROIs to the target values. If these do not match, it yields a not O.K. 
result. Otherwise the function simply counts the existing regions.

Group Parameters
If checked, the range can be adjusted separately for each group of ROIs. It is available 
only, if group numbers have been activated in function Define ROIs. Groups are selected 
in the graphics panel or using the spin buttons below.

Minimum
To be valid, the group has to contain at least this number of ROIs;

Maximum
To be valid, the group has to contain at most this number of ROIs;

In our example the values for minimum and maximum are identical, i.e. the inspection is 
only valid when all 9 pins are present.
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